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The passport of the appraisal fund 

Discipline Digital Technology in medicine 

№ 

п/

п 

The name of the controlled section (topic) of 

the discipline / module 

Codes of 

competence 

Name of 

valuatio

n means 

1 2 3 5 
1 Fundamentals of the digital economy and 

digital health 

Medical Image Recognition Algorithms 

Virtual and Augmented Reality in Medicine 

GPC-10 

 

Test,  

2 Big data and artificial intelligence in healthcare 

Strategy for creating a new model of medical 

institutions based on digitalization. 

GPC-10 Test,  

3 Biomedical Signal Analysis - Digital Signals 

and Images 

Digital images in MATLAB and their 

application in medical research 

GPC-10 

 

Test,  

4 Software for the implementation of information 

processes in medicine. Basic technologies of 

discrete orthogonal and wavelet 

transformations of information. 

GPC-10 

 

Test,  

5 Pre-processing of medical signals and images 

using digital technologies. 

GPC-10 

 

Test,  
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Questions for the exam 

in the discipline "Digital Technology in medicine " 

for 2nd year students of the Faculty of General Medicine 

1. Writing concept and history of digital health 

2. What are the structure, subjects and objects of digital health 

3. What are the needs of self-preservation behavior of the population and the possibilities of 

digital health 

4. List digital health issues (patient, professional, institutional) 

5. To characterize the prospects of digital health care in the self-preservation behavior of the 

population. 

6. Classification of medical images. 

7. How the size of the image matrix and its quality are related. 

8. What are the ways of processing medical images on a computer. 

9. Evidence-based organization and management of the health service. 

10. What is a CAD Computer Assistant System?  

11. What is virtual reality.  

12. Describe the types of virtual reality.  

13. Analyze the pros and cons of virtual reality.  

14. What are the prospects for virtual reality.  

15. Why Mark Zuckerberg invests in VR, why create social networks with augmented reality. 

16. Describe the need for artificial intelligence in healthcare. 

17. Analyze the process of introducing AI in our country. 

18. To characterize the algorithm for modeling the perceptron in the Matlab environment.  

19. What is the need for transformation in health care.  

20. Digital transformation in healthcare - what is it. 

21. Healthcare transformation and value-based treatment comment 

22. What is spectral analysis. 

23. The role of information technology in biomedical research. 

24. Give mathematical definitions of spectral functions and transformations 

25. List the functions of the MATLAB package that generate spectral functions and 

transformations of initial medical signals. 

26. What are the principles of obtaining projections of a tomographic image? 

27. How is the reconstruction of the head phantom based on projection data. 

28. What are the features of the synthesis of projections when using parallel rays? 

29. What are the features of the synthesis of projections when using fan rays? 

30. List the known biomedical signals. 

31. List the main informational characteristics of the ECG signal. 

32. Explain why the R wave of the electrocardiogram is used to form HRV time series. 

33. How the HRV signal is formed from the electrocardiogram recording. 

34. What is the essence of the used algorithm for clearing signals from artifacts. 

35. What type of interpolation is recommended for HRV signals. 

36. Under what conditions the mathematical expectation and the mode are slightly different. 

37. What types of HRV distribution histograms are known. 

38. The concept of digital signal processing systems 

39. The language of mathematical functions MATLAB and SIMULINK 

40. Description of the MATLAB interface 
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41. Working with matrices in MATLAB 

42. Working with graphics in MATLAB 

43. Matrices and Arrays in MATLAB 

44. Flow control in MATLAB 

45. Scripts and Functions in MATLAB 

46. Controlled graphics in MATLAB 

47. Biomedical signals used in medical diagnostics - classification 

48. Block diagram of heart rate variability 

49. Physiological nature of the ECG signal 

50. Mathematical methods for the analysis of biomedical signals 

51. Program for conducting research and importing results into MATLAB 

52. Source signal interpolation - methods in MATLAB 

53. Fundamentals of spectral analysis in the HAARA bases 

54. Definition of wavelet transforms, methods of using them in medical research 

55. Windowed Fourier transforms, a technique for using them in medical research 

56. Methods of object recognition in medical images using MATLAB 

57. What is the result of the direct Fourier transform. 

58. Three main spectral components of short records of HRV signals. 

59. What parameters are included in the equation of continuous wavelet analysis. 

60. How is the scaling parameter of the wavelet transform and the investigated frequency 

related? 

61. List the known basic functions of the wavelet transform. 

62. What shape does the scatterogram of the HRV signal usually have? 

63. How correlation rhythmography is formed. 

64. Estimates of what methods are used to obtain a complex indicator of PARS. 

65. List the contents of the original files of HRV signals. 

66. What methods are used for interpolation of initial signals to obtain estimates. 

67. How many electrodes are used to register HRV signals. 

68. Name the file format of MATLAB environment functions. 

69. What command in MATLAB environment is used to implement fast Fourier transform. List 

the main arguments for this command. 

70. Describe an algorithm for constructing an attractor in the phase space. 

71. What does the multifractal spectrum of a monofractal signal look like? 
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FEDERAL STATE BUDGETARY EDUCATIONAL INSTITUTION OF HIGHER 

EDUCATION "NORTH OSSETIAN STATE MEDICAL ACADEMY" OF THE 

MINISTRY OF HEALTH OF THE RUSSIAN FEDERATION 

REVIEW 

FOR EVALUATION MATERIALS 

 

in the discipline " Digital Technology " 

for 2nd year students 

in the specialty 31.05.01 Medical care 

The evaluation materials were compiled at the Department of Chemistry and Physics on 

the basis of the work program of the discipline " Digital Technology " and comply with the 

requirements of the Federal State Educational Standard in 3++  

The evaluation materials was approved at a meeting of the Central Coordination 

Educational and Methodological Council and sealed with the seal of the educational and 

methodological management. The evaluation materials  means includes a bank of test items and 

questions for the final test for the discipline. 

The bank of test items includes test items and response templates. All tasks correspond to 

the work program of the discipline Digital Technology and cover all its sections. The number of 

test items ranges from 20 to 39. 

There are no comments to the peer-reviewed the evaluation materials. 

In general, the evaluation materials  for the discipline " Digital Technology " contributes 

to a qualitative assessment of the level of students' mastery of universal and professional 

competencies. 

The peer-reviewed the evaluation materials for the discipline " Digital Technology " can 

be recommended for use for intermediate certification for students of 2nd year of study in the 

specialty 31.05.01 General medicine.. 
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Table of contents 

№ 

The name of the 

controlled section (topic) 

of the discipline / module 

Number of 

tests (total) 

Code of 

Competences 

Formed 

p. 

from __ to __ 

1 2 3 4 5 

View 

control 

Intermediate 

1.  Fundamentals of the digital 

economy and digital health 

79 GPC-10 

 
12-25 

2.  Medical Image Recognition 

Algorithms 
53 GPC-10 

 
26-32 

3.  Virtual and Augmented 

Reality in Medicine 
214 GPC-10 

 
33-58 

4.  Big data and artificial 

intelligence in healthcare 
73 GPC-10 

 
58-74 

5.  Strategy for creating a new 

model of medical 

institutions based on 

digitalization 

15 GPC-10 

 
74-76 
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15 GPC-10 

 
76-78 

7.  Digital images in 

MATLAB and their 

application in medical 

research 

8 GPC-10 

 
78-79 

8.  Software for the 

implementation of 

information processes in 

medicine. Basic 

technologies of discrete 

orthogonal and wavelet 

transformations of 

information. 

10 GPC-10 

 
79-81 

9.  Pre-processing of medical 

signals and images using 

digital technologies. 

8 GPC-10 

 
81-82 
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The concept of information. 

General characteristics of the processes of data collection, transmission, processing and 

accumulation. Methods and means of informatization in medicine and public health. 

 

Self-check tests: 

1. The Matlab system is 

a. Universal mathematical system 

b. text editor 

c. algorithmic programming language 

d. system of work with databases 

2. Does not apply to analogs of the Matlab system 

a. Basic 

b. Mathematica 

c. Maple 

3. The Mathematics panel contains 

a. 1.buttons with palettes of commonly used mathematical notation 

b. 2.math buttons 

c. 3.lists of math functions 

d. 4.buttons for programming functions 

4. Symbol: = in Matlab denotes 

a. assignment 

b. equality 

c. approximation 

d. description 

5. The assignment operation in the Matlab document looks like this: 

a. a: = 5 

b. a = 5 

c. a; 5 

d. a: 5 

6. When entering an assignment character from the keyboard, enter 

a. 1.colon 

b. 2.semicolon 

c. 3.space 

d. 4.equal sign 

7. To change the format of the result, you need 

a. 1.changing the number of characters in the Result Format window 

b. 2.add zero to the result 

c. 3.change the precision of calculations 

d. enter the initial data with greater accuracy 

8. Before entering the subscript of the vector element, press the key 

a. one. [ 

b. Shift 

c. Alt 

9. A discrete variable allows 

a. 1.set a variable to a series of numbers arranged in ascending order with equal steps 

b. 2.Set the variable the change interval 

c. 3.change the value of the variable by one 

d. 4.there is no correct answer in the list 

10. Built-in functions located on the Calculator palette are entered into the document 

a. 1.clicking on the function name 

b. 2.only by entering the function name from the keyboard 
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c. 3.selecting the function name on the Calculator palette 

d. 4.there is no correct answer in the list 

11. If, when specifying a discrete variable, the step is omitted, then 

a. 1.step is considered equal to 1 

b. 2.step is considered equal to 0 

c. 3.step is considered equal to 0.5 

d. Error message 

12. Numeric constant TOL is intended for 

a. 1.setting the accuracy for approximate calculations * 

b. 2.setting the number of characters when displaying the result 

c. 3.setting the accuracy of the initial data 

d. 4.setting the number of displayed results 

13. To get a table of values of the function f (x) in a given discrete variable range, enter 

a. 1.f (x) = 

b. 2.f (x): = 

c. 3.f (x) and press the Tab key 

d. 4.f (x)? 

14. User function 

1.must be described before first use * 

2.can be described anywhere in the document 

can not be described 

4.there is no correct answer in the list 

A discrete variable allows 

1.set a variable to a series of numbers arranged in ascending order with equal steps 

2.Set the variable the change interval 

3.change the value of the variable by one 

4.there is no correct answer in the list 

Built-in functions located on the Calculator palette are introduced into the document 

1.clicking on the function name 

2.only by entering the function name from the keyboard 

3.selecting the function name on the Calculator palette 

4.there is no correct answer in the list 

If, when specifying a discrete variable, the step is omitted, then 

1.step is considered equal to 1 

2.step is considered equal to 0 

3.step is considered equal to 0.5 

4. Error message 

The numeric constant TOL is for 

1.setting the accuracy for approximate calculations * 

2.setting the number of characters when displaying the result 

3.setting the accuracy of the initial data 

4.setting the number of displayed results 

To get a table of values of the function f (x) in a given discrete variable range, enter 

1.f (x) = 

2.f (x): = 

3.f (x) and press the Tab key 

4.f (x)? 

User function 

1.must be described before first use * 

2.can be described anywhere in the document 

3. can not be described 

4.there is no correct answer in the list 



11 
 

The input cursor is marked with red cross 

1.Horizontal red line 

2.Red vertical line 

3.there is no correct answer in the list 

The character placeholder is 

1.black rectangle in which the character should be entered according to the format 

2.black rectangular frame into which it is fashionable to enter the formula 

3.red rectangle in which the error message is displayed 

4.there is no correct answer in the list 

You can use the key to navigate from one placeholder to another. 

1. TAB 

2. HOME 

3. END 

4.there is no correct answer in the list 

To remove a part of the formula, you need 

1.select this part and press the Del key 

2.press the Del key 

3.press the Backspace key 

4. There is no correct answer in the list. 

To start entering text directly into the computational area, enter 

1. symbol " 

2.symbol / 

3.symbol \ 

4.symbol? 

At the location marked with the cursor, the graph template appears by 

1.clicking on the appropriate template in the Graph panel 

2. dragging and dropping the chart template 

3. double click on the location marked with the cursor 

4.there is no correct answer in the list 

If the function argument is not described when plotting the graph, then 

1.By default, the graph will be built in the range from -10 to 10 with a step of 1 

2.By default, the graph will be built in the range from -1 to 1 with a step of 0.1 

3.An error message will appear 

4.there is no correct answer in the list 

When plotting 2 or more graphs in one template, the names of the functions are entered 

1.separated by commas 

2.separated by a colon 

3. through a space 

4.there is no correct answer in the list 

To delete a schedule, you need 

1.activate it by clicking the mouse and press the Del key 

2.press the Del key 

3.select the graph with the mouse 

4.there is no correct answer in the list 

To change the graphic color, symbol or line thickness in the Format chart window, use the 

tab 

1. Traces 

2. X-Y Axes 

3. Labels 

4. Defaults 

The symbol “->” (arrow) is intended for 

1.to carry out symbolic calculus 
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2.to enter a comment 

3.for the analytic transformation of the function 

a. 4.to calculate the function 

MATLAB is short for words 

1. Mathematical Laboratory 

2. Matrix Laboratory 

3. Materialized Labor 

MatLab extension packages are called 

1. Toolkits 

2. Tools 

3. Toolboxes 

Of the listed devices, it is optional when working with MatLab. 

1.monitor 

2.processor 

3.printer 

Is MatLab capable of performing operations on complex numbers 

1.yes 

2. no 

In addition to calling programs written in the MatLab language, work in the MatLab 

environment 

can be performed 

1. "in automatic mode" 

2. "in data entry mode" 

3. "in calculator mode" 

Most of the commands and functions of the system are stored as text files with 

enlargement 

1.g 

2. .m 

3. .p 

Which menu in the menu bar of the main MatLab window contains commands to 

display 

and hiding internal program windows 

1. Window 

2. Help 

3. Desktop 

What window of the MatLab system is intended for entering numbers, variables, 

expressions and commands to view calculation results and display program texts 

1. Command History 

2. Command Window 

3. Workspace 

The keys <↓> and <↑> in MatLab serve 

1.to move the cursor down or up on the screen 

2.to move the cursor left or right on the screen 

3.to display commands and expressions previously entered from the keyboard in the input 

line 

If the result of evaluating the expression has not been assigned to any other variable, 

then MatLab always stores it in a variable 

1.inf 

2.ans 

3. NaN 

To separate the integer part of a number from the fractional part in MatLab, use 

1.point 
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2.comma 

3.semicolon 

What format of presentation of calculation results is used in MatLab by 

default 

1.hex 

2.long 

3.short 

To denote the imaginary unit in complex numbers in MatLab is reserved 

two characters 

1.i and j 

2.i n k 

3.j and k 

Does MatLab, like other programming languages, require in advance 

declare variable types 

1.yes 

2. no 

3.to display commands and expressions previously entered from the keyboard in the input 

line 

If the result of evaluating the expression has not been assigned to any other variable, 

then MatLab always stores it in a variable 

1.inf 

2.ans 

3. NaN 

To separate the integer part of a number from the fractional part in MatLab, use 

1.point 

2.comma 

3.semicolon 

What format of presentation of calculation results is used in MatLab by 

Default 

1.hex 

2.long 

3.short 

To denote the imaginary unit in complex numbers in MatLab is reserved 

two characters 

1.i and j 

2.i n k 

3.j and k 

Does MatLab, like other programming languages, require in advance 

declare variable types 

1.yes 

2. no 

What extension do m-files have in MatLab 

1.mat extension 

2. extension. T 

3.extension. f 

What type of M-files can take input data as a set of input parameters and produce results 

as a set of output values 

1.program file 

2.file functions 

Is it correct to say that the variables defined in the file function, after its execution, become 

available in the workspace and can be used in other file functions? 
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1.yes 

2. no 

The created m-file can be saved 

1.only in the current working directory 

2.in any directory for which the search path is set in MatLab 

3.in any directory, regardless of whether it is in the search path 

Choose which of the following statements is true 

1.the name of the m-file in which the file-function is stored can be the same as the name of 

any variable or MatLab command, since all the variables specified in the file-function are 

local 

2.the name of the m-file in which the function file is stored must be unique and must not be 

the same as the function name 

3.the name of the m-file in which the file-function is stored must be unique and must 

necessarily match the name of the function 

Whether it is allowed to call the created file-function from other file-programs or file-

functions 

1.yes 

2. no 

What command should be entered into the command window to call the m-file editor of the 

MatLab system 

1.edit command 

2.cd command 

3.pwd command 

What command should be entered into the command window to call the m-file editor of the 

MatLab system 

1.edit command 

2.cd command 

3.pwd command 

What color the m-file editor uses by default to highlight syntax errors in the program code 

1.blue 

2.red 

3.green 

What symbol allows you to designate a program block as a separate fragment 

1.% symbol 

2. %% symbol 

3. %%% symbol 

How to bring up the dialog used to set search paths 

1.using the FilePreferences command 

2.via the FileSet Path command 

3.the Filelmport Data command 

To get the maximum possible value in MatLab, presented in single precision format, you 

need to enter the command in the command line 

1.realmax ('double') 

2.realmin ('single') 

3.realmax ('single') 

How many bytes is required to store each element of a boolean array 

1.1 byte 

2.2 bytes 

3.4 bytes 

For storing a matrix with zero elements in sparse format 
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1.requires more memory than storing a matrix in normal form (including all zero and non-zero 

elements) 

2.requires less memory than storing a matrix in its usual form (including all zero and non-zero 

elements) 

Which array element is the element k (2, 2) = {'magic'} 

1.cell array 

2.array structures 

3.character array 

If information can be presented in the form of a table with fields containing data of the 

same type, then to store such information, use 

1.cell arrays 

2.arrays of structures 

3.numeric arrays 

To remove an unnecessary field in an array of structures, use the function 

1.fieldnames 

2. getfield 

3.RMF ield 

Which of the following ways of setting a symbolic variable is erroneous in MatLab 

1.setting the numeric character code as an argument to the char function 

2.enter the desired character in apostrophes 

3.type the required character in curly braces 

What function allows you to execute a command formed as a string of characters 

1.eval 

2.feval 

When substituting a variable value in an expression, after the substitute keyword in the 

placeholder, type 

1.boolean expression 

2.variable 

3.formula 

4.constant 

To carry out analytical differentiation, the symbol is used 

one. 

2. = 

3. ≈ 

4. ÷ 

Instead of the differentiation operator placeholder, you need to enter 

1.function depending on the argument and the name of the argument 

2.function name and argument name 

3.the name of the derived function and the name of the argument 

4.there is no correct answer in the list 

Instead of placeholders for the integration operator, it is required to enter 

1.function depending on the argument, the name of the argument and the limits of integration 

2.function name, argument name and integration limits 

3.the name of the derived function and the name of the argument 

4.there is no correct answer in the list 

To carry out analytical differentiation, the symbol is used 

1. = 

2. ≈ 

3.there is no correct answer in the list 

If the integral diverges, then 

1.the error message is issued 
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2.the divergent integral is calculated 

3.integral is replaced by convergent 

4.there is no correct answer in the list 

To move a document design element, you need it 

1.select and drag using mouse 

2.copy and paste to the desired location 

3.remove and paste in the desired location 

4.there is no correct answer in the list 

To resize a document element you need 

1.select and stretch (or shrink) by pulling the black rectangles on the borders of the selection 

area 

2.Draw the mouse several times within the element area 

3. transfer the document element to Word and resize there 

4.there is no correct answer in the list 

Color highlighting is done using 

1.Part Item Properties of the Format menu 

2.Formatting pane 

3.The Refresh item of the View menu 

4.there is no correct answer in the list 

To create a text region, you need to enter the symbol 

1. double quote 

2.colon 

3.opening square bracket 

4. apostrophe 

To format text in Matlab use 

1.formatting panel 

2.Standard panel 

3.Format item of the main menu 

4.there is no correct answer in the list 

To set a paragraph, use 

1.markers on the ruler 

2.Format item of the main menu 

3.formatting panel 

4.there is no correct answer in the list 

The number of copies when the document is sad is set in the window 

1.in the document print window 

2.in the setup page options window 

3.Command Print 

4.there is no correct answer in the list 

To get the maximum possible value in MatLab, presented in single precision format, you 

need to enter the command in the command line 

1.realmax ('double') 

2.realmin ('single') 

3.realmax ('single') 

How many bytes is required to store each element of a boolean array 

1 byte 

2 bytes 

4 bytes 

For storing a matrix with zero elements in sparse format 

1.requires more memory than storing a matrix in normal form (including all zero and non-zero 

elements) 
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2.requires less memory than storing a matrix in its usual form (including all zero and non-zero 

elements) 

Which function allows you to create a template of a cell array (an array of a given size with 

empty cells) 

1.cellldisp function 

2.cell function 

3.struct 

If information can be presented in the form of a table with fields containing data of the 

same type, then to store such information, use 

1.cell arrays 

2.arrays of structures 

3.numeric arrays 

To remove an unnecessary field in an array of structures, use the function 

1.fieldnames 

2. getfield 

3.RMF ield 

Which of the following ways of setting a symbolic variable is erroneous in MatLab 

1.setting the numeric character code as an argument to the char function 

2.enter the desired character in apostrophes 

3.type the required character in curly braces 

What function allows you to execute a command formed as a string of characters 

1.eval 

2.feval 

The Matlab system is 

1.Universal mathematical system 

2.text editor 

3.algorithmic programming language 

4.system of work with databases 

Does not apply to analogs of the Matlab system 

1. Basic 

2. Mathematica 

3. Maple 

The Mathematics panel contains 

1.buttons with palettes of commonly used mathematical notation 

2.math buttons 

3.lists of math functions 

4.buttons for programming functions 

Symbol: = in Matlab denotes 

1.assignment 

2.equality 

3.approximation 

4.description 

The assignment operation in the Matlab document looks like this: 

1.a: = 5 

2.a = 5 

3.a; 5 

4.a: 5 

When entering an assignment character from the keyboard, enter 

1.colon 
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2.semicolon 

3.space 

4.equal sign 

To change the format of the result, you need 

1.changing the number of characters in the Result Format window 

2.add zero to the result 

3.change the precision of calculations 

4. enter the initial data with greater accuracy 

Before entering the subscript of the vector element, press the key 

one. [ 

2. Shift 

3. Alt 

4. 

A discrete variable allows 

1.set a variable to a series of numbers arranged in ascending order with equal steps 

2.Set the variable the change interval 

3.change the value of the variable by one 

4.there is no correct answer in the list 

Built-in functions located on the Calculator palette are entered into the document 

1.clicking on the function name 

2.only by entering the function name from the keyboard 

3.selecting the function name on the Calculator palette 

4.there is no correct answer in the list 

If, when specifying a discrete variable, the step is omitted, then 

1.step is considered equal to 1 

2. 

3.step is considered equal to 0 

4.step is considered equal to 0.5 

5. Error message 

Numeric constant TOL is intended for 

1.setting the accuracy for approximate calculations * 

2.setting the number of characters when displaying the result 

3.setting the accuracy of the initial data 

4.setting the number of displayed results 

To obtain a table of values of the function f (x) in a given discrete variable range, enter 

1.f (x) = 

2.f (x): = 

3.f (x) and press the Tab key 

4.f (x)? 

A discrete variable allows 

set a variable to a series of numbers arranged in ascending order with equal steps 

set variable to change interval 

change the value of a variable by one 

there is no correct answer in the list 

Built-in functions located on the Calculator palette are introduced into the document 

by clicking on the function name 

only by entering the function name from the keyboard 

by highlighting the function name in the Calculator palette 

there is no correct answer in the list 

If, when specifying a discrete variable, the step is omitted, then 

step is considered equal to 1 
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step is considered equal to 0 

the step is considered equal to 0.5 

Error message 

The numeric constant TOL is for 

setting the accuracy for approximate calculations * 

setting the number of characters when displaying the result 

setting the accuracy of the source data 

setting the number of displayed results 

To get a table of values of the function f (x) in a given discrete variable range, enter 

f (x) = 

f (x): = 

f (x) and press the Tab key 

f (x)? 

User function 

must be described before first use * 

can be described anywhere in the document 

need not describe 

there is no correct answer in the list 

The input cursor is marked with 

red cross 

horizontal red line 

red vertical line 

there is no correct answer in the list 

The character placeholder is 

black rectangle in which the character should be entered according to the format 

black rectangular frame into which it is fashionable to enter a formula 

red rectangle in which the error message is displayed 

there is no correct answer in the list 

You can use the key to navigate from one placeholder to another. 

TAB 

HOME 

END 

there is no correct answer in the list 

To remove a part of the formula, you need 

select this part and press the Del key 

press the Del key 

press the Backspace key 

There is no correct answer in the list. 

To start entering text directly into the computational area, enter 

symbol " 

symbol / 

symbol \ 

symbol ? 

At the location marked with the cursor, the chart template appears by 

clicking on the appropriate template in the Graph panel 

drag-and-drop chart template 

double-click on the location marked with the cursor 

there is no correct answer in the list 

If the function argument is not described when plotting the graph, then 

by default, the graph will be built in the range from -10 to 10 with a step of 1 
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by default, the graph will be built in the range from -1 to 1 with a step of 0.1 

an error message will appear 

there is no correct answer in the list 

When plotting 2 or more graphs in one template, the names of the functions are entered 

comma separated 

colon separated 

through a space 

there is no correct answer in the list 

To delete a schedule, you need 

activate it by clicking the mouse and press the Del key 

press the Del key 

select the graph with the mouse 

there is no correct answer in the list 

To change the graphic color, symbol or line thickness in the Format chart window, use the 
tab 

Traces 

X-Y Axes 

Labels 

Defaults 

The symbol “->” (arrow) is intended for 

to carry out symbolic calculations 

to enter a comment 

for analytic function transformation 

to calculate the function 

The simplify keyword is used 

 when simplifying expressions 

 when factoring an expression 

 when reducing similar terms 

 there is no correct answer in the list 

The factor keyword is used 

 when factoring an expression 

 when simplifying expressions 

 when reducing similar terms 

 there is no correct answer in the list 

The parfrac keyword is used 

 when determining the polynomial coefficients 

 when simplifying expressions 

 when reducing similar terms 

 there is no correct answer in the list 

The collect keyword is used 

 when reducing similar terms 

 when determining the polynomial coefficients 

 when simplifying expressions 

 there is no correct answer in the list 

For the analytical solution of problems of mathematical analysis, the panel is designed 

 Mathematics 

 Formatting 

 Standard 

 Calculator 

To perform the operation of substituting the value of a variable into an expression, use the 

keyword 



21 
 

 substitute 

 complex 

 solve 

 laplace 

When substituting a variable value in an expression, after the substitute keyword in the 

placeholder, type 

 boolean expression 

 variable 

 formula 

 constant 

2. To carry out analytical differentiation, use the symbol 

 

 = 

 ≈ 

 ÷ 

3. Instead of a placeholder for the differentiation operator, you need to enter 

 function depending on argument and argument name 

 function name and argument name 

 derived function name and argument name 

 there is no correct answer in the list 

4. Instead of placeholders for the integration operator, it is required to enter 

 function depending on the argument, the name of the argument and the range of 

integration 

 function name, argument name and limits of integration 

 derived function name and argument name 

 there is no correct answer in the list 

5. To carry out analytical differentiation, the symbol is used 

 = 

 ≈ 

 there is no correct answer in the list 

6. If the integral diverges, then 

 an error message is displayed 

 the divergent integral is calculated 

 the integral is replaced by the convergent 

 there is no correct answer in the list 

7. To move a document design element, you need to 

 select and drag using mouse 

 copy and paste to the desired location 

 remove and paste at the desired location 

 there is no correct answer in the list 

8. To resize a document element you need 

 select and stretch (or shrink) by pulling the black rectangles on the borders of the 

selection area 

 drag the mouse several times within the element area 

 transfer a document element to Word and resize there 

 there is no correct answer in the list 

9. Color selection is made using 

 Item Properties item of the Format menu 

 Formatting pane 

 of the Refresh item of the View menu item 

 there is no correct answer in the list 
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10. To create a text region, you need to enter the symbol 

 double quote 

 colon 

 open square bracket 

 apostrophe 

11. To format text in Matlab, use 

 Formatting panel 

 Standard panel 

 Format item of the main menu 

 there is no correct answer in the list 

12. To set a paragraph, use 

 markers on the ruler 

 Format item of the main menu 

 Formatting panel 

 there is no correct answer in the list 

13. The number of copies when the document is sad is set in the window 

 in the document print window 

 in the page options setup window 

 with the Print command 

 there is no correct answer in the list 
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